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 PREFACE 

 
 
Today, everything from playing football and to check the weather can be done 

on a computer through additional gadgets. Computer is becoming more 
common and used in everyday every purpose life. So now it is necessity for all 
of us to learn the basics of computer. We have designed Training Module for 
Basic Computer Training for Institutes. The systematic learning with day to 
day task is strength of this book. The basics of computer include- 
 

a. Microsoft Paint 

Use of Mouse,  draws the pictures shapes.  
b. Notepad 

Use of Key board, basic typing. 
Opening, Moving Folders.  

c. Microsoft word 
Write, Edit the documents  

d. Microsoft Excel 
Calculate, analyzing the data  

e. Microsoft PowerPoint 
Presentation for data  
 
We have provided simple exercises and assignment of each topic. 

 

 

 
Author:  

 
Archit Gulia, B.Tech 
Shahbaz Alam, BCA 
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MS PAINT 

 

DAY 1  

 
DEFINITION OF MS PAINT  

 
Microsoft Paint or MS Paint (MSP) is a legacy graphics drawing program that has 
been shipped with all versions of Windows. MSP is an easy way to create different 
kinds of graphics, with tools such as brushes, erasers, pens and shape generators. 
 

HOW TO OPEN MS PAINT 
 

Step1- Left click on Windows Button 
Step2 - Left click on All Programs  
Step3 - Left click on Accessories  
Step4 - Left click on Paint  
 

INTRODUCTION OF MOUSE  

 

The mouse helps you move the cursor around on the computer screen. 
 
 
 
 
 

 
 

 

 
  

 
 

 

 
MOUSE ACTIONS  

1. Click 

2. Double click  

3. Right click 
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4. Point  

5. Drag  

 

 

✍ 
➢ New  

➢ Open  

➢ Save 

➢ Save As 

 

 

✍ 
➢ Draw Line  

➢ Eraser size Increase & Decrease  
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DRAW A HUT 

✍ 

 

 

✍  
➢ Fill color in Hut 
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DAY 2  

 
DRAW SHAPES 

✍ 

 

 
 

✍  

➢ Fill color in Shapes,  

➢ Fill Color:- Crayon , Marker Oil, Watercolor etc. 
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TEXT  

✍ 

 

 
 

✍ 

 

➢ Fill color in Text 

 

✍ 

 

 
➢ File,  

➢ Folder,  

➢ Move, 

➢ Copy,  

➢ Delete file and folder 

➢ Changing Display Wallpaper,  

➢ Icons & Shortcuts Increase/ Decrease size (Control + Mouse Scroll)  

➢ Set as wallpaper, Remove from wallpaper.  
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DAY 3 

 

INTRODUCTION OF KEYBOARD 
 

Alphabet Keys, Numeric Keys , Special Character, Modify keys (Shift , Control, Alt ), Caps Lock, 
Numeric lock, escape, back space, Enter, Delete, Home End, PageUp, Page down. 
 
Caps Lock On ………………. Capital Letters 

Caps Lock Off ………………. Small Letters  

 
 

MS NOTEPAD 
➢ New  

➢ Open, 

➢ Save 

➢ Save As 

➢ Print 

 

TYPE SENTENCES  

✍ 

➢ Type 7 times.  

 
The quick brown fox jumps over the lazy dog 
Select single line with Key board (Shift + arrow) and  mouse 

➢ Copy & Paste 

➢ Cut & Paste 

➢ Undo 

➢ Delete 
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DAY 4  
 

FIND, REPLACE & TIME, DATE, FONT 

✍ 

Type the Para 
On July 16, 1969, the Apollo 11 spacecraft launched from the Kennedy Space Center in Florida. 
Its mission was to go where no human being had gone before—the moon! The crew consisted 
of Neil Armstrong, Michael Collins, and Buzz Aldrin. The spacecraft landed on the moon in the 
Sea of Tranquility, a basaltic flood plain, on July 20, 1969. The moonwalk took place the 
following day. On July 21, 1969, at precisely 10:56 EDT, Commander Neil Armstrong emerged 
from the Lunar Module and took his famous first step onto the moon’s surface. He declared, 
“That’s one small step for man, one giant leap for mankind.” It was a monumental moment in 
human history! 
 
Find : Neil  
Find and Replace :  Moon – Jupiter  
 
 
 
 
0 
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MS WORD 

 
UNIT 1- HOME 

 
DAY 1 

 

DEFINITION OF MS WORD 

 

Microsoft Word 2010 is a word-processing software, designed to help you create professional-
quality documents. With the finest document formatting. 
 

HOW TO OPEN MS WORD 

 
Step1- Left click on Windows Button 

Step2 - Left click on All Programs  
Step3 - Left click on Microsoft Office 
Step4 - Left click on Microsoft Word 2010   
 

WINDOW INTRODUCTION OF MS WORD 
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FILE TAB 

 
The File Tab (see Figure 1), located in the top left corner of the window, replaces the Office 

Button (see Figure). 
 

 
Figure 1 – The File Tab (Word 2010) 

 

CREATING A DOCUMENT 

 

1. Click the File Tab. 
2. Click New. 

3. Select Blank document and then click Create. 
 

 

 
 

 

1.  HOME TAB  

This is the most used tab; it incorporates all text formatting features such as font and paragraph 
changes. 
 

 
Copy Ctrl + C  
Cut     Ctrl + X  

Paste  Ctrl + V 
 

Start New line Press Enter Key 
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TYPE SENTENCE  

 
The quick brown fox jumps over the lazy dog.  
 

HOW TO SAVE DOCUMENT 

 
When you create a document it is important to save the document so that it can be 
viewed or reused later. The basic steps to save a document are listed below; 

o Click on the File Tab 

o Click on the  Save As  or Save (Ctrl + S , F12) docx, pdf file  

o it displays 'Save As' Dialogue Box 

o Save the document to desired location with a desired name 

 

 

✍ 
➢ Type 5 times this sentence 
➢ The quick brown fox jumps over the lazy dog.  
➢ Do copy paste 5 times separate line  
➢ Do save document on desktop  
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DAY 2 
 
 

TYPE THE PARA  

 
On July 16, 1969, the Apollo 11 spacecraft launched from the Kennedy Space Center in Florida. 
Its mission was to go where no human being had gone before—the moon! The crew consisted 
of Neil Armstrong, Michael Collins, and Buzz Aldrin. The spacecraft landed on the moon in the 

Sea of Tranquility, a basaltic flood plain, on July 20, 1969. The moonwalk took place the 
following day. On July 21, 1969, at precisely 10:56 EDT, Commander Neil Armstrong emerged 

from the Lunar Module and took his famous first step onto the moon’s surface. He declared, 
“That’s one small step for man, one giant leap for mankind.” It was a monumental moment in 

human history! 

 

✍ 
 

➢ Calibri Font (Ctrl + Shift + F) 
➢ 12 Point Size   1. Increase (Ctrl + ])  2. Decrease (Ctrl + [) 
➢ Bold (Ctrl + B) 
➢ Italic (Ctrl + I) 
➢ Underline (Ctrl + U) 
➢ Strikethrough  

 

 

DAY 3 

SUPERSCRIPT (CTRL + SHIFT + +) 

 

A2 
B2 
x2 
23 
102 
1002 
H2o 
CO2 
H2S 
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Ca2+ 

Fe3+ 
X2+y2=z2 

a+b)2 = a2 + b2 + 2ab 

(a-b)2 = a2 + b2 - 2ab 

a2-b2 = (a+b) (a-b) 
 

SUBSCRIPT (CTRL + =) 

 
A2 
B2 
X2 
23 
102 
1002 
Hg2 
NH4 
MnO4 
GaAsO4 
Na3PO4 

C6H12O6 
Mg(OH)2 

CH3COOH 
Ca4A16O12SO4 
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DAY 4 
 

FORMATTING  

 
A Computer is a programmable machine designed to perform arithmetic and 
logical operation automatically and sequentially on the input given by the user 
and gives the desired output after processing. 
 

Computer Components 
 
“Are divided into two major categories namely” 

 

Hardware        Software 
 

✍ 
• Text Effects (Gradient Fill Purple) 
• Text Highlight Color (Yellow) 

• Font Color (Red) 

• Alignment Center (Ctrl + E ) 

 

CHANGE CASE 

 
THE QUICK BROWN FOX JUMPS OVER THE LAZY DOG.   (Tell Case) 

✍ Change to Lowercase 
 
tHE qUICK bROWN fOX jUMPS oVER tHE lAZY dOG.  (Tell Case) 

✍ Change to Capitalize Each Word 
 
the quick brown fox jumps over the lazy dog.  (Tell Case) 
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✍ Change to Uppercase  
 
The Quick Brown Fox Jumps Over The Lazy Dog. (Tell Case) 

✍ Change to Toggle Case 
 
The Quick Brown Fox Jumps Over The Lazy Dog. (Tell Case) 

✍ Change to Sentence Case 
 
 
 

DAY 5 

 BULLETS 

 

 

❖ Sporting Equipment  

➢ Baseball 

▪ Baseball glove 

▪ Baseball 

▪ Bats 

➢ Basketball 

▪ Basketballs 

➢ Golf 

▪ Golf clubs 

▪ Golf balls 
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✍ 
➢ Bullets  
➢ Tab key 

➢ Line Spacing (1.5) 

 

NUMBERING 

 
 

1. Computer Parts  
 

a. CPU 
b. Monitor 
c. Keyboard 
d. Mouse 
e. Printer 

 
2. Stationary Name 

 
a. Notebook 
b. Pen 
c. Pencil 
d. Pad 
e. Ink  

 
 

✍ 
➢ Tab key 
➢ Line Spacing (1.0) 
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MULTILEVEL LIST 

 
❖ Section 1:  

 

▪ Apple 

▪ Orange 

▪ Kiwi 

▪ Budget  

▪ Cost 

▪ Remaining 

❖ Section 2: 

 

▪ Coffee 

▪ Tea 

▪ Hot Chocolate 

 Budget 

 Cost  

 Remaining 

 

✍ 
➢ Tab key 
➢ Line Spacing (1.5) 



MS Word 
 

https://onlinestudytest.com Page 24 

 

DAY 6 

SORTING 

 
Computer       

Printer 

CPU 

Mouse 

Scanner 

Light Pen 

Keyboard 

Flash Drive 

Disk Drive 

Webcam 

Joystick 

CD/DVD Drive 

 

✍ 
➢ A to Z Ascending Order  

 

 

SHADING & BORDERS 

 
Input Device Name 
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https://onlinestudytest.com/


MS Word 
 

https://onlinestudytest.com Page 25 

 

Keyboard 

Mouse 

Scanner 

Microphone 

Light Pen 

 
Output Device Name 
 

Monitor 

Printer 

Speaker 

Plotters 

Projector 

 
 
 

✍ 
➢ Shading Color 
➢ All Borders 
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DAY 7 
 

LE SSON 1 A  GOD  LE TTER 

Lencho had predicted, big drops of rain began to fall. In the north-east huge mountains of 
clouds could be seen approaching. The air was fresh and sweet. The man went out for no other 
reason than to have the pleasure of feeling the rain on his body, and when he returned he 

exclaimed, ‘‘These aren’t raindrops falling from the sky, they are new coins. The big drops are 
ten cent pieces and the little ones are fives.’’ With a satisfied expression he regarded the field 

of ripe corn with its flowers, draped in a curtain of rain. 

LESSON 2 ENVIORMENT  

Whitaker puts his trust not just in his own skills, but also in the aspirations of younger 
generations: "We are doing a lot of work with young people, bringing them to the forest and 

showing them what happens here and why it matters. It can be very difficult to change adult 
attitudes, but with the young, it is easier to get across the knowledge that what we are doing to 

the forests we are doing to ourselves." 

LESSON 3 BENEFITS OF COMPUTERS 

Indeed computer is very helpful device, it is used in all fields and at every walk of life. It is a 

boon for mankind. All inventions are very beneficial but sometimes these inventions become a 

bane for mankind. Because of computer and its wide use human have forgot to work. 

 It has reduced manual work, it has affected human activity and has made man lazy. We have 
become slave to our own invention. The human to human interaction and communication is 

broken. 

People prefer using free time in front of computers or laptops instead of communicating with 
family members and relatives. The internet access on computer help increase many social evils 
like immorality. 

✍ 
➢ Heading 1 
➢ Heading color  
➢ Heading Font  
➢ Paragraph Spacing  
➢ Go to Navigation Pane 
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DAY 8 
 

On July 16, 1969, the Apollo 11 spacecraft launched from the Kennedy Space 
Center in Florida. Its mission was to go where no human being had gone before—
the moon! The crew consisted of Neil Armstrong, Michael Collins, and Buzz Aldrin. 
The spacecraft landed on the moon in the Sea of Tranquility, a basaltic flood plain, 
on July 20, 1969. The moonwalk took place the following day. On July 21, 1969, at 
precisely 10:56 EDT, Commander Neil Armstrong emerged from the Lunar Module 
and took his famous first step onto the moon’s surface. He declared, “That’s one 
small step for man, one giant leap for mankind.” It was a monumental moment in 
human history! 
 

✍ 
➢ Find -> Neil  
➢ Replace -> Moon – Jupiter 
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UNIT 2 INSERT 

 
DAY 9 

 
2. Insert Tab 
 
This tab allows you to insert a variety of items into a document from pictures, clip art, tables 

and headers and footers. 
 

 
 

COVER PAGE 

 
 

 

✍ 
➢ Conservative Cover Page 
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DAY 10 

FRUITS TABLE 

 

 

Fruits Name Quantity Rate Total Amount  
Apple 50 Kg 85 Rs 4250 

Orange 80 Kg 30 Rs 2400 

Pineapple 25 Kg 65 Rs 1625 
Litchi 40 Kg 60 Rs 2400 

Grapes 12 Kg 40 Rs 480 

Guava 10 Kg 25 Rs 250 

Kiwi 10 Kg 85 Rs 850 
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✍ 
➢ 3 x 8 Table 

➢ Do Multiply  [Quantity x Rate = Total Amount]  

STUDY SCHEDULE 

 
Sr.No Time Monday Tuesday Wednesday Thursday Friday Saturday 

1 7:50 
To 

8:35 

            
English 

            
Science        

                        
Mathematics 

            
Computer 

   
Grammar 

   
Computer 

2 8:45 

To 
9:30 

 

Mathematics 

    

Computer 

          

Science        

       

Mathematics 
 

 

Science 

 

Science 

3 9:50 

To 
10:35 

 

Computer 

 

Mathematics 

 

English 

 

Grammar 

 

Computer 

 

Grammar 

4 10:45 
To 

11:30 

  
Grammar  

 
Science 

 
Computer 

 
Science 

 
English 

 
Mathematics 

5 1:00 
To 

1:45 

 
Lunch  

 
Lunch 

 
Lunch 

 
Lunch 

 
Lunch 

 
Lunch 

6 1:55 

To 
2:40 

 

Science 

 

Grammar 

 

English 

 

English 

 

Mathematics 

 

English 

7 2:50 
To 
3:35 

 
Assignment  

 
Assignment 

 
Assignment 

 
Assignment 

 
Assignment 

 
Assignment 

 

 

✍ 
➢ 8 x 8 Table 
➢ Insert Row 
➢ Insert Column  
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DAY 11 

INSERT PICTURE 

 

 The school is the place that prepares us for a 
good tomorrow. I love my school because it is one of the best schools.The 
classrooms of my school are wide, large and airy. Our school has a very large 
playground where we play sports. There is a computer lab, science lab and a big 
library in my school. All of the teachers of my school are very kind and 
cooperative. 

 

✍ 
➢ Insert pic 
➢ Type the Para 
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CLIP ART 

  This is Computer.  

This is a Floppy disk. 
 

This is a Kite. 
 

✍ 
➢ Insert Clip Art 
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SHAPES 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
 
 
 
 
 

✍ 
➢ Insert Shapes 
➢ Shape Style 
➢ Text Direction  
➢ Align Text 

 
 

Knowledge  Offer 
60 % 

D
o

w
n

   

The earlier you start working on 
something, the earlier you will 
see results.” 
Life is short. Live it. Fear is 
natural. Face it. Memory is 
powerful. Use it. 
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DAY 12 

 SMART ART 

 

 
 

 

CPU Monitor Printer

Keyboard Mouse

5 14 19
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✍ 
➢ Change Colour 

 
 

CHART 

 

 
 

✍ 
➢ Apply Data 

 May June  July 

Jeans 95 85 74 

T- Shirt 98 56 98 

Top 80 42 65 

Jacket 40 65 50 

 
 

0

20

40

60

80

100

120

Jeans T- Shirt Top Jacket

May

June

July
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✍ 
➢ Apply Data 

 Amount 

Mahin  4000 

Alam 2000 

Haider 2000 

Shaziya 1500 

 
 

 
 
 
 
 
 
 

 

Amount

Mahin

Alam

Haider

Shaziya
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DAY 13 

HYPERLINK 

✍ 
 
➢ Word Hyperlink 
➢ Basic Course SOP.docx 

 
➢ Notepad Hyperlink 
➢ wps.txt 

 
➢ Image Hyperlink 
➢ ssi.jpg 

 
 

HEADER & FOOTER 

 

✍ 
➢ Header -> Super Success Institute  
➢ Footer -> Bypass Flyover, Jansath Road, Near Gokul City, 

Shernagar, Muzaffarnagar  
 

 

PAGE NUMBER  

 

✍ 

https://onlinestudytest.com/
file:///C:/Users/Naaz%20Computer/Desktop/Office/Basic%20Course%20SOP.docx
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➢ Top  
➢ Bottom 

 
 

TEXT BOX 

 
 
 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 

✍ 
➢ Alphabet Quote 

 
 

Nobody can go 

back and start a 

new beginning, 

but anyone can 

start today and 

make a new 

ending. 
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DAY 14 

WORD ART 

 

 

 

✍ 
➢ Super Success Institute  

➢ Word Art Style 
➢ Shape Style 
➢ Text Fill 
➢ Text Outline 
➢ Text Effects 
➢ Transform  
➢ Shadow 
➢ Shape Fill 
➢ Shape Outline  
➢ Shape Effects 

 

DATE & TIME 

✍ 
➢ 19-05-2021 
➢ Wednesday, 19 May 2021 
➢ 19 May 2021 
➢ 2021-05-19 
➢ 19-05-2021 18:18 
➢ 6:18:35 PM 
➢ 19-05-2021 18:18:41 
➢ May 21 
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EQUATION & SYMBOL 

 

✍ 
 
 

𝑦 =
𝑏±√𝑎2+6𝑎𝑐

9𝑎
 

 

sin 𝛼 ± sin 𝛽 = 8 sin
7

5
(𝛼 ± 𝛽) cos

4

2
(𝛼 ∓ 𝛽) 

 
 
 

α 
¶ 
™ 
© 
≥ 
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UNIT 3 PAGE LAUOUT 

 
DAY 15 

 

3.  PAGE LAYOUT TAB 

 
This tab has commands to adjust page elements such as margins, orientation, inserting 

columns, page backgrounds and themes. 
 

 
 

COLUMNS 

 
 

A Thirsty Crow 
 
Once upon a time, 

there used to be a 

crow in a forest, it 
was the summer time 

in which everyone, 
whether an animal or 

animal, is in great 

need of water, no 
human can live 

without water and no 

animal. So water is 
very important. That 

crow was very upset 

for a few days 

because he had not 

got water for a long 
time.  

And he was in a lot of 
trouble due to thirst, 

he was in need of 

water. But he was not 
getting water 

anywhere, due to lack 

of water, he was 
getting rid of shaking. 

One gets water from 

anywhere but he does 

not get water. 
One day the thirsty 
crows were feeling 

that they would not be 
able to survive 

anymore, its last time 

had come. So he 
thought that if I do 

not get water, I will 

die. 

 

 

✍ 
➢ Three Columns  
➢ Line Numbers 
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➢ Hyphenation 
 
 
 
 
 

DAY 16 

WATERMARKS 

 
 
 

✍ 
➢ Super 
➢ Font Calibri  

 

PAGE COLOR 

 
 

✍ 
➢ White  
➢ Black 

➢ Red 
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PAGE BORDERS & HORIZONTAL LINE 
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✍ 
➢ Font Calibri  
➢ Size 24,12,14 

➢ Horizontal Line 
➢ Indent  
➢ Spacing  
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UNIT 4 REFERENCES  

DAY 17 
 

4 .  REFERENCES TAB 

 
This tab has commands to use when creating a Table of Contents and citation page for a paper. 
It provides you with many simple solutions to create these typically difficult to produce 

documents. 

 

 
 

 

 
 
 

COMPUTER  

 

A computer is an electronic device that receives input, stores or processes the input as per user 

instructions and provides output in desired format. Computers have become an integral part of 
our lives because they can accomplish easy tasks repeatedly without getting bored and complex 

ones repeatedly without committing errors. 

CHARACTERISTICS OF COMPUTER  

 

SPEED 

Typically, a computer can carry out 3-4 million instructions per second. 
 

ACCURACY  

Computers exhibit a very high degree of accuracy. Errors that may occur are usually due to 
inaccurate data, wrong instructions or bug in chips – all human errors. 

RELIABILITY   

https://onlinestudytest.com/


MS Word 
 

https://onlinestudytest.com Page 46 

 

Computers can carry out same type of work repeatedly without throwing up errors due to 
tiredness or boredom, which are very common among humans. 

VERSATILITY   

Computers can carry out a wide range of work from data entry and ticket booking to complex 
mathematical calculations and continuous astronomical observations. If you can input the 

necessary data with correct instructions, computer will do the processing. 

STORAGE CAPACITY  

Computers can store a very large amount of data at a fraction of cost of traditional storage of 
files. Also, data is safe from normal wear and tear associated with paper. 

SOFTWARE  

 

As you know, the hardware devices need user instructions to function. A set of instructions that 
achieve a single outcome are called program or procedure. Many programs functioning 
together to do a task make a software. 

 

SYSTEM SOFTWARE 

 

Software required to run the hardware parts of the computer and other application software 
are called system software. System software acts as interface between hardware and user 

applications. An interface is needed because hardware devices or machines and humans speak 
in different languages. 

 

APPLICATION SOFTWARE  

 

A software that performs a single task and nothing else is called application software. Application 

software are very specialized in their function and approach to solving a problem. So a spreadsheet 
software can only do operations with numbers and nothing else. A hospital management software 
will manage hospital activities and nothing else. 
 

 

✍ 
➢ Heading 1 (Level 1) 
➢ Heading 2 (Level 2) 
➢ Table of Contents (Inbox) 
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➢ Update Table 
 

 
 

DAY 18 

INSERT FOOTNOTE & ENDNOTE 

 
1ISP stands for. This helps in providing direct access for using the internet from 
your office or home, connected through landlines. With the introduction of 2Wi-fi 
and broadband, connecting to the Internet has become wireless. 

 

✍ 
➢ Footnote 
➢ Endnote is the insert end page of document  
➢ Next Footnote 

➢ Show Notes 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
1 Internet Service Provider 
2 Wireless Fidelity  
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DAY 19 

INSERT CITATION & BIB BIBLIOGRAPHY 

 
 

BIBLIOGRAPHY 
Ms Word [Book] / auth. Ali. - Muzaffarnagar : Al- Haider, 2020. 

 

 

✍ 

 

 

✍ 
➢ Manage Sources 
➢ Style GOST Title 
➢ Insert Bibliography 
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DAY 20 

INSERT CAPTION 

 
Figure 1 ................................................................................................ Error! Bookmark not defined. 
Figure 2 ................................................................................................ Error! Bookmark not defined. 
 

Table 1 ................................................................................................. Error! Bookmark not defined. 

 
 
 
 
FIGURE 1              

 

              F IGURE 2  
 

 
 

TABLE 1 

 

Employee Names June July August September 

Dennis 19000 18000 15000 16000 

John 18000 20000 17000 19000 

 

 

✍ 
➢ Insert Caption 
➢ Insert Table of Figures 
➢ Cross Reference add Link Bibliography in Index   
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UNIT 5 MAILINGS 

DAY 21 
 

5.  MAILINGS TAB 

 
This tab allows you to create documents to help when sending out mailings such as printing 
envelopes, labels and processing mail merge. 

 

 
 
 

 

LETTER 

✍ 
 
 
 Name 
Address 
City 
Date 
 
Dear  
 
I hope this letter finds you in the best of health and spirits. You will be 
glad to know that my birthday falls on 13th Nov. I am going to celebrate 
my birthday at home. We shall have a dance and music program. I have 
invited all my friend. I hope you will also come and join my birthday 
party. 

 

https://onlinestudytest.com/


MS Word 
 

https://onlinestudytest.com Page 51 

 

 

✍ 

RECIPIENTS LIST 

 
Name Address City Date 

Ali Haider A to Z colony Meerut 2-Nov-2021 

Virat Singh Ram Vihar Delhi Road Meerut 2-Nov-2021 
Arohi Bhardwaj Near Bus station  Pune  3-Nov-2021 

Dennis Near G T B Hospital  Bangalore 3-Nov-2021 

John  A To Z colony  Muzaffarnagar 3-Nov-2021 
Mr. Zaidi Gandhi Nagar  Delhi 4-Nov-2021 
Mr. Archit  Laxmi Nagar  Delhi  4-Nov-2021 

Shakshi Yamuna Vihar  Goa  8-Nov-2021 
Mahin Alam Anand Vihar  Aligarh 8-Nov-2021 

Richard Aliya imam Bargha Lucknow 8-Nov-2021 

 

✍ 
➢ Insert Merge 
➢ Preview results  
➢ Finish Merge 
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UNIT 6 REVIEW  

 
DAY 22 

 

6.  REVIEW TAB 

 
This tab allows you to make any changes to your document due to spelling and grammar issues. 
It also holds the track changes feature which provides people with the ability to make notes and 
changes to a document of another person. 
 

 
 
 

 

SPELLING GRAMMAR & RESEARCH  

 

On the Insert tab, the galleries include items that are designed to coordinate with 
the overall look of your document. You can use these galleries to insert tables, 
headers, footers, lists, cower  pages, and other docment building blocks. 
When you create pictures, charts, or diagrams, they also coordinate with your 
current docment look. You can easily change the formatting of selected text in the 
docment text by choosing a look for the selected text from the Quick Styles 
gallery on the Home tab. 
 
 

✍ Spelling 
➢ docment -  document 
➢ cower – cover 

✍ Research 
➢ Formatting 
➢ Insert 
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DAY 23 

WORD COUNT 

 
Pandit Jawaharlal Nehru presented the National Flag of India to the 
Constituent Assembly of India on July 22, 1947. Our National Flag is 
rectangular in shape and is made from cotton, khadi, wool or silk cloth.  
 
The ratio of the width of the flag to its length is always 2:3. The 
National Flag has three equal horizontal stripes of different colours. 
There is saffron (kesari) at the top, white in the middle and green at the 

bottom. This is why it is also called the tricolour. 
 
The colours of the tricolour have special meanings. The saffron stands 
for courage and sacrifice. The white stands for truth and peace. The 
green stands for prosperity. In the centre of the white stripe is a navy-
blue wheel which represents the chakra.  
 
It symbolises progress. Its design has been taken from the Sarnath Lion 
Capital of Ashoka. It is also called the Ashoka Chakra.  
 
 

✍  
➢ Page 
➢ Words 
➢ Lines  
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UNIT 7 VIEW 

 
DAY 24 

 

7. VIEW TAB  

 
This tab allows you to change the view of your document to a different two page document or 
zoom. 

 

 
 
 

 

 

✍  
➢ Print Layout  
➢ Full Screen Reading 
➢ Web Layout 
➢ Outline 
➢ Draft 
➢ Ruler 
➢ Gridlines 
➢ Zoom 
➢ New Window  
➢ Arrange All 
➢ Split 

➢ View Side by Side 
➢ Switch Windows 
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MS EXCEL 

 

UNIT 1 HOME TAB  

DAY 1  
 

DEFINITION OF MS EXCEL 

 
MS Excel is spreadsheet software it is combination of Rows & Columns. That allows users to organize, format 
and calculate data with formulas using a spreadsheet system and can perform mathematical operations. 

HOW TO OPEN MS EXCEL  

 
Step1- Left click on Windows Button 
Step2 - Left click on All Programs  
Step3 - Left click on Microsoft Office 
Step4 - Left click on Microsoft Excel 2010   

WINDOW INTRODUCTION OF MS EXCEL 
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File Tab 

CREATING A WORKBOOK 

 
1. Click the File Tab. 
2. Click New. 
3. Select Blank workbook than double click and click Create. 
 

 
 

EXCEL ARITHMETIC OPERATORS  
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Direct at any Cell, We can use like that 
 

=10+5 
=10-5 
=10*5 

=10/5 
 

 
 

 
 

First of all the formula start symbol “=” Type  =10+5 than press Enter key Execute 15 
 

HOW TO SAVE WORKBOOK  

 
When you create a workbook it is important to save the workbook so that it can be 

viewed or reused later. The basic steps to save a workbook are listed below; 

o Click on the File Tab 

o Click on the  Save As  or Save (Ctrl + S , F12) xlsx, pdf file  

o it displays 'Save As' Dialogue Box 

o Save the workbook to desired location with a desired name 
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1. ADDITION 

 
 

 
 

✍ 
➢ Font Calibri  
➢ Size 12, 11 
➢ Bold 
➢ Alignment (Center)  
➢ Copy Cut Paste (G to I) Cells 
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2. SUBTRACTION 

 

 
 

 

✍ 
➢ Fill Color (Yellow) 
➢ Font Color (Red) 
➢ Borders (All Borders) 
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DAY 2 
 

✍ 
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4. DIVISION 

✍ 
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DAY 3 

5. SUM 

✍ 
 

 
 

6.MAX 

&  

7.MIN 

✍ 
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DAY 4 

WRAP TEXT 

✍ 
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MERGE & CENTER 

✍ 
 

 
 

 

✍ 
➢ Number (Accounting) 
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DAY 5  

ORIENTATION 

✍ 

 
 

✍ 
➢ Angle clockwise 
➢ Rotate text up 
➢ Merge , Wrap text etc. 
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DAY 6 
 

Conditional Formatting  
 

GREATER THAN 

✍ 
 

 

 

✍ 
➢ Highlight Value Greater Than = 100 
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LESS THAN 

✍ 
 

 
 

✍ 
➢ [A] Value Less Than = 190 
➢ [B] Value Less Than = 350 
➢ [C] Value Less Than = 500 
➢ [D] Value Less Than = 600 
➢ [E] Value Less Than = 700 
➢ [F] Value Less Than = 800 
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BETWEEN 

✍ 
 

 

✍ 
➢ Total bill values between 9000 to 15000 
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DAY 7 
 

EQUAL  

✍ 

 
 

✍ 
➢ Score values equal = 90 
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TEXT THAT CONTAINS 

✍ 

 
 
 

✍ 
➢ Text that contains = Apple 
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DAY 8 

DATE OCCURRING 

✍ 

 
 

✍ 
➢ Create the recently dates and apply same conditions 
➢ Yesterday, Today, Tomorrow, Last 7 Days, Last Week, This Week, Next 

Week, Last Month, This Month & Next Month. 
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DUPLICATE & UNIQUE 

✍ 
 
 

 
 
 

✍ 
➢ Select duplicate & unique in the data column. 
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DAY 9 

TOP/BOTTOM RULES 

✍ 

 
 
 

✍ 
➢ Top 10 items, Top 10 % items, Bottom 10 items, Bottom 10 % items, 

Above average, Below average. 
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DATA BARS 

 

✍ 

 
 
 

✍ 
➢ Data bars  
➢ Color scales 
➢ Icon sets 
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DAY 10 

FILTER  

 

✍ 

 
 

✍ 
➢ Format as table (Dark 11) 
➢ Cells style (Note) 

 

✍ 
➢ Sort :- A to Z [Employee Name]  

 

✍ 
➢ Filter :-  12000 [Advance payment]  
➢ Filter :-  9-Feb-21 [Joining date] 
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✍ 
➢ Find :- Devid  
 

✍ 
➢ Replace :- Dennis – Dennis Ritchie  
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UNIT 2 INSERT TAB 

 

DAY 11 
 

 
 

PIVOT TABLE 

✍ 

 
 

✍ 
➢ Month Name , Income, Expensive & Employee Salary 

 

✍ 
➢ Table 
➢ Picture 
➢ Clip Art 
➢ Shapes 
➢ Smart Art 
➢ Screenshot 
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DAY 12 

CHARTS 

✍ 

 
 

✍ 

 

✍ 
Name  Salary  

Mohd 35000 

Ali 29000 

Eshika 24000 
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➢  

 
 

✍ 
➢ Hyperlink 
➢ Text Box 
➢ Word Art  
➢ Equation  
➢ Symbol 

 
  

Raman 22000 

Raghav 20000 
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UNIT 3 PAGE LAYOUT TAB 

 

DAY 13 

 

 
 
 
 
 

✍ 
➢ Themes, Colors, Fonts, Effects. 
➢ Margins  
➢ Orientation 
➢ Size 
➢ Print Area 
➢ Breaks 
➢ Background 
➢ Print Titles 
➢ Gridlines 
➢ Headings 
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UNIT 4 FORMULAS 

 

                                                      DAY 14 
 

  
 

 

8. UPPER 

✍ 
 

 
                           Pasted as values  

✍ 
➢ Upper  
➢ Paste Special  
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9. LOWER 

 
 

✍ 

 

 

 

 

10. PROPER 

 

✍ 
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DAY 15 

11. TRIM 

 

✍ 
 

 

 

 

12. LEFT  
 

✍ 
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DAY 16 

 

13. MID  

✍ 

 

 

 

14. RIGHT 

 

✍ 
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15. LENGTH 

✍ 
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DAY 17 
 

16. CONCATENATE  

✍ 

 

 

17. EXACT 

 

✍ 
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DAY 18 
 

18. IS NUMBER  

✍ 

 

 

 

 
 

19. IS TEXT 

 ✍ 
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20. IS EVEN 

 

✍ 

 

 

 

21. IS ODD 

✍ 
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22. ABS 

✍ 

 
 
  



MS EXCEL TASK 

https://onlinestudytest.com Page 92 

 

DAY 19 
 

23. ROUND 

  

✍ 

 

 
 
 

24. AVERAGE 

 

✍ 
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DAY 20 

25. COUNT 

✍ 
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26. COUNTA 

✍  
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27. COUNTBLANK 

✍ 
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DAY 21 

28. VLOOKUP 

✍ 
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DAY 22 
Conditions Formulas 

29. IF 

 

✍ 
 

 
 
 

✍ 
➢ PASS ………  Above 300  
➢ FAIL………… Below 300  

 

✍ 
➢ Show formulas  
➢ Error checking 
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DAY 23 
 

30 NESTED IF 

 

✍ 

 
 

✍ 
➢ D……….  Less than 35 
➢ C……….   35 To 49 
➢ B……….   50 To 74 
➢ A………   75 To 100 
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✍ 

 
 

✍ 
➢ Poor……………..  1 To 149 
➢ Satisfied……….  150 To 199 
➢ Good…………….  200 To 359 
➢ Excellent……….  360 Above 

 

 
 
 

 
 
  



MS EXCEL TASK 

https://onlinestudytest.com Page 100 

 

DAY 24 
 

31 OR 

 

✍ 
 

 
 
 

✍ 
➢ 45 % ……………… Anyone sales amount greater than and equal 5000  
➢ Not Bonus………. All sales amount less than 5000  
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32 AND 

✍ 
 

 
 
 

✍ 
➢ 52 % ……………… All sales amount greater than and equal 12000  
➢ 12 % ………. Anyone/all sales amount less than 12000  

 

 

✍ 
➢ Evaluate formula 
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DAY 25 
 

FORMAT CELLS 

✍ 
 

 
 
 

 

✍ 
➢ Select the row and do right click select format cells Go to Custom     
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UNIT 5 DATA TAB 

 

DAY 26 
 

 
 

 

REMOVE DUPLICATES 

✍ 
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Data Validation 

DROP DOWN LIST 

✍ 

 
 

TEXT LENGTH 

✍ 

 
✍ 

➢ Aadhaar Card No ……Text Length…. 12 Equal to  
➢ Contact No …………… Text Length …. 10 Equal to  
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UNIT 6 REVIEW TAB  
 

DAY 26 
5 Review Tab 

 

 
 

 

COMMENT 

 

✍ 
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UNIT 7 VIEW TAB 

 

✍ 

WORKBOOK VIEWS  

SHOW 

ZOOM 

WINDOW 

 
 

 

 

 

FORMULAS SOLUTIONS 

 
 
8. Upper 
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9. Lower 
 

 
 
 
 
 
 
 
 
 
10. Proper 
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11. Trim  
 

 
 
 
12. Left 
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13. Mid 
 

 
 

 
14. Right  
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15. Length 
 

 
 
 
 
 
16. Concatenate  
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17. Exact  
 

 
 
 
 

 

 

 

18. Is Number 
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19. Is Text  
 

  

 

 
 
20. Is Even 
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21. Is Odd 
 

 
 

 

 
 
22. Abs 
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23. Round  
 

 

 

 
24. Average 
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25. Count 
 

 
 

 
26. Counta 
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27. Countblank  
 
 

 
 

 

28. Vlookup 
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29. IF 
 

 
 

 
30. Nested IF 
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31 OR 
 

 
 
32 AND 
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MS POWERPOINT 

 
 

 
DEFINITION OF MS POWERPOINT 

 
Microsoft PowerPoint is a presentation Software. The software allows users to create anything 
from basic slide shows to complex presentations. PowerPoint is often used to create business 
presentations, but can also be used for educational or informal purposes. 
 

HOW TO OPEN MS POWERPOINT  

 
Step1- Left click on Windows Button 
Step2 - Left click on All Programs  
Step3 - Left click on Microsoft Office 
Step4 - Left click on Microsoft PowerPoint 2010 
 

WINDOW INTRODUCTION OF MS POWERPOINT 

 
-
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PAREPARE PRESENTATION ON WATER 
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SLIDE 1 

✍ 
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SLIDE 2 

✍ 
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SLIDE 3 

✍ 
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SLIDE 4 

✍ 
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SLIDE 5 

✍ 
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SLIDE 6 

✍ 

 

 

✍ 
 

➢ New Slide 
➢ Font Style & Size  
➢ Design  
➢ Clip Art 
➢ Word Art. 
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